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1. Introduction

XPanel : a system for the dynamic display of the data acquired by LSI LASTEM dataloggers.

It consists of: a communicator (XPanelCommunicator) that receives data from acquisition units and
transmits them over the network through a TCP connection, and a viewer (XPanelViewr) that shows
received data display pages containing different indicator types.

XPanel is perfect for installations where computer and data acquisition devices are permanently
connected via a serial cable, line potentiometers, TCP/IP networks or radio: all connections
allowing a real time update of the indicators.

1.1. New features in version 1.4

Main new features in version 1.4:

e It has been added the support for MQTTCommNet program to use new AlphalLog
datalogger.

1.2. New features in version 1.3

Main new features in version 1.3:

e The main innovation introduced with version 1.3 is the management of sound alarms. Now
it is possible to bind to the control a sound alarm which is activated in case of error in the
data or status value in alarm. The sound alarm continues until the user does not recognize it.
(§ 5.8).

e [t has been improved the automatic reconnection mechanism that is activated when
XPanelViewer loses its connection with XPanel Communicator

e [t has been fixed some minor problems of Table and Wind Rose Indicators.

1.3. New features in version 1.2

Version 1.2 presents some new features especially in the viewer component:

e We have added a new control named Label States Indicator. This control displays a series of
states, defined by a range of values, showing a text or an image (§ 5.7.2.13).

e We have changed the management of the size of the font used in the controls by introducing
a scaling factor that changes the font size; once identified the optimal size for a control, you
can extend this setting to all controls so that the titles of all the controls on the page are the
same size (§ 5.7.2.2)

e The Table control has undergone several improvements, now you can:

o record the minimum and maximum values selecting the reset time;

o resize the data column widths respect to the Date Time one;

o change the font size of table rows; now it is related to the one of the title of the
control;

o remove the title aligning the table to the upper border of the control.

e The background image that can be associated to a page acquires the size of the page, so
resizing page does not alter the position of the control relative to the background.

4
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e The Label Indicator can now be associated to a data source by displaying the received value
after the text of the label.

e It has been improved the management of checks at loading configurations and fixed some
minor bugs.

In the communication component were fixed some small problems in the configuration check and

has been changed the method of calculation for the invalidation factor of data for the devices that
communicate via CommNetEG (§ 4.5.3.1):

2. System Requirements

The program requires the following hardware and software components:

Personal computer

e Processor with operating frequency of 600 MHz or more, | GHz recommended;
¢ Display card: SVGA resolution 1024x768 or more; standard screen resolution (96 dpi).
e Operating system (*):
o Microsoft Windows 7/2003/8/2008/2010
e Microsoft NET Framework V.3.5 (**);

(*) Operating systems must be updated with the latest update released by Microsoft and
available through Windows Update; for operating systems not listedis not guaranteed correct
and complete operation of programs.

(**)The Microsoft. NET Framework 3.5 setup 1s included in the LSI Lastem
product DVD issued after March 2011 and, if necessary, is automatically installed during the
installation process starts from the DVD. If you do not have the updated version of the DVD you
can download the installer for the Microsoft. NET Framework 3.5 directly from the Microsoft
Download Center at http://www.microsoft.com/downloads/en/default.aspx inserting in the search
field. the term ".NET".

On Windows 8 you can enable. NET Framework 3.5 manually from the Control Panel . In the
Control Panel you can use Add Programs and Features , then Enable or disable Windows features
and then select the check box Microsoft. NET Framework 3.5.1. . This option requires an Internet
connection.

The program makes use of NLog component (Copyright (¢) 2004-2009, Jaroslaw Kowalski All
rights reserved).

Data Loggers

e LSI LASTEM Data loggers: E-Log, R-Log, M-Log, S-Log; data radio communicator LSI
LASTEM R-Comm.
e LSILASTEM Data loggers: AlphaLog with MOTTCommNet program.

3. XPanel Components

XPanel consists of two components:
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e  XPanelCommunicator: is the program that communicates with instruments and makes instant
data available over the network via a TCP connection; to operate, it requires the 3DOM
program to be installed on the same computer.

e XPanelViewer: is the program that receives data from the communicator and displays them.

3.1. Single computer configuration

In the typical configuration based on a single computer, 3DOM programs, XPanelCommunicator
and XPanelViewer are installed on the same instrument:

e 3DOM configures the instruments whose data need to be displayed;
e XPanelCommunicator interrogates instruments and makes data available;
e XPanelViewer displays the received data.

3.1.1. Instructions for use

How to use Xpanel on a single computer:

1. Install 3DOM, XPanelCommunicator and XPanelViewer programs on a PC;

Configure the instruments (devices) by using 3DOM program; if the instruments are already

configured, configurations should in any case be downloaded to your computer;

Install the licenses for the instruments (devices) to be used with XPanel Communicator;

4. Start XPanelCommunicator program and create a new configuration by adding the
instruments (devices) to be used with the program;

5. Start XPanelViewer program and create a new configuration by entering the TCP 127.0.0.1
address and the port configured in XPanelCommunicator program (default 9997) as
configuration parameters;

6. Check for proper data reception

[99)

3.2. Client-Server network configuration

In a client-server network configuration, 3DOM and XPanelCommunicator are installed on the
server computer, while only XPanelViewer needs to be installed on client computers.

On the server:
e 3DOM configures the instruments whose data need to be displayed;
e XPanelCommunicator interrogates the instruments and makes data available through a TCP
connection.

On client computers:
e XPanelViewer displays the data that were made available by XPanelCommunicator.

3.2.1. Instructions for use

How to use XPanel in a Client-Server configuration:
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Server Computer

1. Install 3DOM and XPanelCommunicator programs on the Server Computer;
Configure the instruments (devices) by means of 3DOM program; if the instruments are
already configured, configurations should in any case be downloaded to your computer;

3. Install the licenses for the instruments (devices) to be used with XPanelCommunicator;

4. Start XPanelCommunicator program and create a new configuration by adding the
instruments (devices) to be used with the program;

5. Start communication and check for proper operation.

Client Computer

6. Install XPanelViewer program on the Client Computer;

7. Start the program and create a new configuration by entering the server computer TCP
address and the port configured in XPanelCommunicator program as configuration
parameters;

7. Check for proper data reception.

3.3. Use in association with CommNetEG

XPanelCommunicator communication program can communicate directly with the different devices
configured by 3DOM or use the instant data produced by CommNetEG. In this case the
communication with the various devices is performed by CommNetEG (2.5.3.0 version or higher).

3.3.1. Instructions for use

How to use XPanel system in association with CommNetEG:

Computer Communication

1. Install 3DOM, CommNetEG and XPanelCommunicator programs on the Server Computer;

8. Configure the instruments (devices) by means of 3DOM program,; if the instruments are

already configured, configurations should in any case be downloaded to your computer;

2. Configure CommNetEG by associating all the devices (instruments) to be used with XPanel
to the XPanelFile data storage support. Instruments can belong to different groups and store
processed data as well: what matters is that they save the instant data to the XPanelFile data
storage support in order to make data available by XPanel,

Install the licenses for the instruments (devices) to be used with XPanelCommunicator;

4. Start XPanelCommunicator program and create a new configuration by adding the

instruments (devices) starting from CommNetEG configuration(§4.5.3);

Start communication and check for proper operation.

6. As to XPanelViewer program, proceed as indicated in the previous paragraphs depending on
whether the program is installed on the same computer or on a client computer.

[98)

e

ATTENTION
If the configuration of a device (or of CommNetEG) or of the communicator is modified at a
later date, the Viewer configuration as well could be influenced by the change and need an
update. (§5.4)

ATTENTION
Both programs are started by automatically loading the current configuration at previous switch

off.
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3.4. Use in association with MQTTCommNet

XPanelCommunicator communication program can communicate directly with the different devices
configured by 3DOM or use the instant data produced by MQTTCommNet In this case the
communication with the various devices is performed by MQTTCommNet.

3.4.1. Instructions for use

How to use XPanel system in association with MQTTCommNet:

Computer Communication

7. Install 3DOM, MQTTCommNet and XPanelCommunicator programs on the Server
Computer;

9. Configure the instruments (devices) by means of 3DOM program; if the instruments are
already configured, configurations should in any case be downloaded to your computer;

8. Configure MOTTCommNet by associating all the devices (instruments) to be used with
XPanel,;

9. Install the licenses for the instruments (devices) to be used with XPanelCommunicator;

10. Start XPanelCommunicator program and create a new configuration by adding the
instruments (devices) starting from MOTTCommNet configuration(§4.5.3);

11. Start communication and check for proper operation.

12. As to XPanelViewer program, proceed as indicated in the previous paragraphs depending on
whether the program is installed on the same computer or on a client computer.

ATTENTION
If the configuration of a device (or of MOQTTCommNet) or of the communicator is modified at a

later date, the Viewer configuration as well could be influenced by the change and need an
update. (§5.4)

ATTENTION
Both programs are started by automatically loading the current configuration at previous switch

off.
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4. XPanelCommunicator

XPanelCommunicator program communicates directly with instruments and makes instant data
available through a TCP connection. Instantaneous data can be obtained by communicating directly
with the instruments or by using the data files generated by the CommNetEG and MOQTTCommNet
programs.

4.1. User interface

The program main window is displayed as shown below:

= ~

ij_"- XPanelCommunicater - New Configuration (CASWnumStuffsh223\Dati EsempitMew Configuration.ipc) = | S -
Eile Edit  Connection Wiy Optiaons Tools 7
- | . |
02 H @& & [ | @
Mame Lazt Acquisition D ate Status
CEMTRO SIT [1]- 051100... 9/26/2011 3:27:03 PM Ready
GIaRDIMG [1] - 09040643 9/26/2011 32715 PM Palled data received
15:27:07:592 [Info] Adding reasure devices on field bus CEMTRO SIT. -
15:27:07:657 [Info] Setting enabled state for device 0 on field bus CEMTRO SIT to Falze.
15:27:07:675 [Info] Adding measure devices on field bus GlARDINO.
15:27:07:B86 [Info] D atalogger working infoz created.
15:27.07.682 [Info] Checking devices configuration...
15:27:.07:997 [Info] Starting datalogger. .. 5
J_j_"- Configuration: Mew Configuration

Specifically:

e the top of the window shows the communication status indicators of the different configured
devices: holding the mouse pointer over an indicator displays its name, clicking an indicator
selects also the corresponding item in the list.

e for each configured device, the list contains the date of the last acquisition and the
communication status (that corresponds to a specific color of the corresponding indicator)

e the program operation log display is shown at the bottom of the list: selecting an item
displays additional info.

4.1.1. Menu

The program includes these menus:

File
e New: creates a new configuration.
e Open: opens an existing configuration.
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Close: closes the current configuration.

Save: saves the current configuration.

Save As: saves the current configuration with a new name.

Recent Configurations: displays the list of recently opened configurations.
Exit: closes the program.

Edit
o Edit Current Configuration: stops communication and opens the window for the current
configuration modification.

Connection
e Start Receiving Data: starts communication with instruments making the received instant
data available;
e Stop Receiving Data: stops communication with instruments.

View
o [nstant Values: displays the window showing the available measuring instruments and those
where the association between measurements and quantities used for calculations is already
configured.
e Clear Log List: clears the list of log messages displayed by the program without changing
the log file contents.
e Go to Log Folder: opens the folder where the log files generated by the program are stored.

Options

e Settings: shows the window with the program general settings.
Tools

e License Manager: starts the licenses management program.

I+~

e (ontents: shows the program user manual.
o Check for Updates: sends a request for available updates;
e About: shows the program information window.

Some of these menu items are available also as button bar under the main window menu; place the
mouse pointer on a button and wait for a brief description.

4.1.2. Colors of communication indicators

Based on the communication status, indicators have the following colors:
o O white: system in a stop condition

. .blue: communication channel connected, system ready for communication

Oyellow: communication in progress

Olight green: communication with device took place correctly and new measurements
were acquired

dark green: communication with device took place correctly

10
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Oorange: a random communication error was detected with the apparatus connected to the
communication channel

.red: a continuous communication error was detected with the apparatus connected to the
communication channel

.purple: connection error of communication channel

Olight grey: communication channel disconnection in progress
dark grey: system was started with communication channel not connected (serial, TCP)
light blue: communication channel connection in progress

.black: critical error occurred in the communication channel

4.2. Program general settings

The program general settings administration window is opened through the Options = Settings

menu:

| Program Settings - [ﬁ

@ Thiz form howes program zettingz; change of certain ikems requires a restart of
communications

&L Network | i Configuration

| Enable remote addministration
TCP paort for remote administration 9336 =
TCP port to request text data fram remote 9338 =
TCP port to zend data to xPaneliewer 9357 =
W Ok | | Cancel

The following can be entered in this window:

TCP port for data transmission to XPanelViewer in the Network tab,

Hide warning messages on loading configuration option in the Configuration tab; if this
option is NOT selected and warning messages are generated during the configuration loading
process, the program displays the message window and waits for the operator’s intervention.
Selecting this option sets the program for automatic startup. Any warning messages are
shown in the status bar of the program and can be displayed by clicking the icon.

L |
[| !‘EWarnings an Io;ii-ﬁ‘gﬂij Configuration: Mew Configuration H

11
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4.3. Program startup: last configuration automatic
loading

If the program is closed when a certain configuration is being used, this will be automatically
reloaded at the next restart of the program and communications will be automatically restarted.

4.4. Opening a configuration

To open an existing configuration, select File = Open menu or File = Recent Configurations
menu. After loading the configuration, the program activates communications with devices and
starts making data available through the TCP connection associated to the instrument where the
program is installed and to the port indicated in the program general settings.

4.5. Creating/changing a configuration

To create a new configuration, select File > New menu; to change an existing one, select Edit =
Edit Current Configuration menu.

If a new configuration is being created, the program will close the current one; if the current
configuration is being changed, the program will stop communications.
In both cases, the window for the configuration change will be displayed:

i Configuration edit . “ E‘E‘é]

@ Thisz form shows the current configuration. Use <Add Device: button to add new devices; zelect an item on the configuration panel and change
itz properties; uge contextual menu on configuration nodes bo remave items from the configuration,

Ldd Itemn °‘ﬁ§']: [1]- 09040643

= -:j:; Mevs Configuration
=3, CENTROSIT @ Device parameters: select one to get mare information
o el [1]- 05110008
= L, GIARDINO

-

YN [1] - 03040543 DBVice|

V| Communication enabled

Instrurnent network, address

b aw retries 3 =

Timeaut 3] 3 =

|E]Messages | | ¥ Dk | |-‘\ Cancel |

The window displays the list of communication channels and connected devices on the left;
selecting an item, a detail is shown on the right allowing the change.

Devices can be added and queried directly by the program (§ 4.5.2) or can be used the data created
by the programs CommNetEG (§ 4.5.3) and MOTTCommNet .

12
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4.5.1. Configuration parameters

Each configuration requires to specify the parameters shown in the following figure:

: TestConmmidl
@

@ Determines how much data iz uzed for the calculation of the
general statistics of each data acquired by the instant device,
shawn in the form of statistical dragaed. -

Configuration

Clock. sprchronization rate [hom:g) 1 &0 =0 =
Quantity data uzed for the dragged statistical calculation 10 =

Ivalid update time factor 5 =

Selecting an item displays a brief description of its meaning (in this case, it explains how much
data is used for the dragged statistics).

4.5.1.1. Data invalidation factor and warning message of not updated values

The program periodically evaluates the condition of each measurement based on the value of its
update rate. If, for instance, a measurement has an update rate of 20 seconds, the program indicates
the measurement as not updated in case a new value is not received within a period of time given by
(update rate) x (data invalidation factor). If, for instance, the data invalidation factor value is 5, the
measurement will be considered as updated after 100 seconds (20 x 5).

When XPanelCommunicator sends a warning message about a measurement not being updated,
controls associated to this measurement in the XpanelViewer pages report an error condition.

Since the data invalidation factor is one, while measurement update rates are many, the program
recommends — based on the current measurements — a minimum value that allows to prevent the
data- not-updated message from being sent in case of regular communications. The minimum
recommended value is determined by the highest invalidation factor calculated for each device
based on its interrogation rate and on current measurements.

Example:

Datalogger 1:
e TInterrogation rate: 60 seconds

e Minimum update rate of measurements: 10 seconds
Datalogger 2:

e Interrogation rate: 10 seconds
e Minimum update rate of measurements: 10 secondi

In this case, the data invalidation factor for Datalogger I is 6, and 1 for Datalogger 2; the data
invalidation factor recommended by the program will be 6 (the highest among the factors
calculated).

4.5.2. Adding a new device

To add a new device, select the <Add Item> -> <Add Device> button:

13
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¥

i Add Device : Lo | O S |

@ Thiz iz the lizt of available and licenzed devices: select one from the list and then press the <Add: button,
or double chick an item on the list to add selected device to the configuration.

Senal Hurmber Izer Senal Mumber D ezcription Firrwsare
E-Log - Envirenmental Data Logger
sl 15110008 Centro SIT prova 01.00.02
19040643 Giardino Giardino 02.10.M
11010037 11010037 02.11.00
3 Add || Close

, ~

The Add Device window shows the list of available devices.

ATTENTION
Only the devices that meet the following requirements are available:
e A valid license was installed for the use of the device with XPanel Communicator program;
e The device configuration was downloaded from the current computer through 3DO
program M.

Selecting the desired device will make the device be added to the communication channel that
shows the same communication type or, failing this, a new communication channel suitable for the

device administration will be created.

To remove a device or a communication channel, select one from the list, then select <Remove>
from the context menu accessible through a right-click of your mouse.

4.5.2.1. Configuration of a communication channel

Communication channels are automatically created when a device showing a communication type
not compatible with the current communication channels is added.
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L] CEMTRO-SIT
—

Communication channel parameters: select one to get more
infarmation

Communication Channel

Marne CEMTRO-SIT

Fiate of interragation G0

Ll

Invalidation time factor a

Communication channel type: TCP

192.168.191.107: 700

Communication parameters CANNOT be changed (in this case, it’s a TCP communication on
192.168.191.101:7001 address), but only the Rate of interrogation (in seconds) and the
Interrogation offset (in seconds) can be changed, that is, the extra time after the interrogation time
in order to allow a remote system update. Selecting an item displays a brief description of its
function (the icon shows the description of the Rate of interrogation parameter).

ATTENTION

It is recommended to check that the Rate of interrogation of the communication channel is NOT
higher than the minimum update rate of the measurements of all the included devices in order to
prevent a data loss due to the finite dimension of the storage queue of device instant data.

For this reason, when a device is added, the program assigns the minimum update rate value of the
device measurements as the Rate of interrogation of the communication channel.

4.5.2.2. Device configuration
When a device is added, this is configured based on the configuration parameters used by 3DOM.

o 4}' [1]- 09040643

@ Device parameters: select one to get more information

Drevice

| Communication enabled

Inztrument network, address

M an retries 3 =
Timeout =] 3 =
Inztrument need wakeup Iz pollable

List of measures

Mame Update Rate [zec) it
2 UrniditaRe3M (%) E0
(% Tempania3d ['C] E0

Selecting an item shows a brief description of its function. The details window displays the list of
the available measurements as well. “Instrument needs wakeup” and “Is pollable” options are
generally default settings based on the device type and cannot be changed.

To disable communication with a device, deselect the Communication enabled box.
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4.5.3. Adding CommNetEG -administered devices

To add the devices administered by CommNetEG program, select <Add item> -> <Add
CommNetEG Configuration™> button.

Choosing this option creates a communication channel containing all the devices included in the
current CommNetEG configuration that were set in order to save the instant data in “XPanelFile”
storage support. XPanel Communicator program DOES NOT directly interrogate the single devices
but extracts data from the text files generated by CommNetEG.

Note that:

e The program uses the current CommNetEG configuration and checks the devices that make
use of XPanelFile storage support at every startup or download;

e Only the devices that have a valid license for XPanel are added to the communication
channel; note that if some of the CommNetEG-configured instruments don’t have the license
to use XPanelFile storage support, they are not added and the program will inform — at every
startup — that the number of CommNetEG-configured instruments differs from the number in
the corresponding communication channel.

o If CommNetEG configuration is changed, CommNetEG communication channel will have to
be removed and regenerated, taking into consideration that this operation could impact on
XPanelViewer configuration.

Instrument network address, max retries, Timeout (s) parameters have no significance for the
devices added to the CommNetEG communication channel and therefore cannot be changed. In this
case the user interface shows the interrogation rate used by CommNetEG for the selected device.

4.5.3.1. Rate of interrogation and data invalidation factor

The rate of interrogation of the communication channel associated to CommNetEG represents the
frequency with which XPanelCommunicator checks for the availability of new data in the text files
generated by CommNetEg program.

In the calculation of the data invalidation factor (§ 4.5.1.1) for the devices in the CommNetEG
communication channel, the program uses the maximum value between the interrogation rate of the
CommNetEG communication channel and the interrogation rate used directly by CommNetEG.

Example:

CommNetEG interrogation 1: every 10 minutes, device measurements
updated every 5 minutes
CommNetEG interrogation 2: every 20 minutes, device measurements
updated every 5 minutes

If the interrogation rate of the XPanelComunicator communication channel is set to the fastest rate
value (interrogation I every 10 minutes), the data invalidation factor recommended by the program
is calculated using the worst case and then is set to 4 (20/5). In this way 10 minutes after the
XPanelCommunicator call we avoid that the measures of the devices included in the interrogation 2
are put on error.

If CommNetEG uses only one interrogation to request the instant data of all the devices, we suggest
to set the interrogation rate of XPanelCommunicator with the same rate used by CommNetEG.
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4.5.3.2. Data files generated by CommNetEG
Data files generated by CommNetEg are included in:

{CommonApplicationData} LSI-Lastem\XPanelCommunicator\CommNetEGInstFiles

Where { CommonApplicationData} corresponds to:
e C:\ProgramData) in Windows Vista and Windows 7

e C:\Documents and Settings\All Users\Application Data\ in
Windows XP

4.5.4. Adding MQTTCommNet administered devices

To add the devices administered by MQTTCommNet program, select <Add item> -> <Add
MQTTCommNet Configuration> button.

Choosing this option creates a communication channel containing all the devices included in the
current MOTTCommNetEG configuration. XPanelCommunicator program DOES NOT directly
interrogate the single devices but extracts data from the text files generated by MQTTCommNet.

Note that:

e The program uses the current MOTTCommNet configuration and checks the devices that
make use of XPanelFile storage support at every startup or download;

e Only the devices that have a valid license for XPanel are added to the communication
channel; note that if some of the MOTTCommNet -configured instruments don’t have the
license to use XPanelFile storage support, they are not added and the program will inform —
at every startup — that the number of MOTTCommNet -configured instruments differs from
the number in the corresponding communication channel.

o If MOTTCommNet configuration is changed, MOTTCommNet communication channel will
have to be removed and regenerated, taking into consideration that this operation could
impact on XPanelViewer configuration.

Instrument network address, max retries, Timeout (s) parameters have no significance for the
devices added to the MOTTCommNet communication channel and therefore cannot be changed. In
this case the user interface shows the interrogation rate used by MOTTCommNet for the selected
device.

4.5.4.1. Data files generated by MQTTCommNet
Data files generated by MQTTCommNet are included in:

{CommonApplicationData} LSI-Lastem\XPanelCommunicator\CommNetEGInstFiles

Where { CommonApplicationData} corresponds to:
e C:\ProgramData\ in Windows 7 and superior

e C:\Documents and Settings\All Users\Application Data\ in
Windows XP

4.6. Configuration compatibility with XPanelViewer
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XPanelViewer program uses XPanelCommunicator configuration as a starting point for assigning
the values detected by devices to the different graphic controls displaying them. If the
communicator configuration is changed, also the viewer configuration might need to be changed.

XPanelViewer program checks for the adequacy of the data sources associated to the single
controls, identifying the controls connected to inexistent data sources and those connected to the
data sources that have been changed while trying to restore them.

Specifically, the changes that make also the viewer configuration update suitable are the following:

e Removal of a communication channel: if a communication channel is removed, all
XPanelViewer graphic controls that had been connected to the devices of that communication
channel will no longer receive data. The list of these controls is indicated in the
XPanelViewer interface (§ 5.5).

o Change of a communication channel name: XPanelViewer uses the name assigned to the
communication channel to associate data to graphic controls; in these instances,
XPanelViewer looks for the device associated to controls in all communication channels,
automatically performing a correction and communicating the change (§ 5.5).

e Adding a device to a communication channel: to display a new device data, XPanelViewer
configuration should be changed by adding the controls that make use of the new device.

e Removing a communication channel device: if a communication channel device is removed,
all XPanelViewer graphic controls that had been connected to that device will no longer
receive data.

These changes are communicated to XPanelViewer instances, that make use of the changed
configuration, only during the download of the corresponding XPanelViewer configuration.
Therefore, special attention must be paid to the changes made to XPanelCommunicator
configuration.

Any changes that might influence a viewer configuration are reported in the edit window:
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171: Configuration edit = B Eg

@ This form shows the current configuration. Use <Add Devicer button to add new devices; select an item on the configuration panel and
change its properties; uze contextual menu on configuration nodes to remove ikems from the configuration.

@ Edit configuration messages L&J

Contral the edit messages and decide whether to save or to discard configuration changes. Click on a
item to get additional informations.

Meszage
ﬁ Last device [[1] - 05110008) removed frmo the communication channel.

If the measures of this device are used in data visualization controls of XPaneliewer theese controls will no longer
show these data

Close

———————
-

QE] Messages ] |)'/" Ok | |n Carcel |
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_ﬂ Configuration changes could prevent <Paneliewer to dizplay some values. Show
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A warning message appears at the bottom of the panel. Selecting the <Messages> button allows to
check the list of the changes that might need a modification of the corresponding XPanelViewer
configurations.

4.7. Changing communication parameters

When a new device is added to a new configuration, it is added to the communication channel of
the same communication type. If no communication channels have the appropriate requirements, a
new channel is created.

ATTENTION

If the need arises to change the type of communication of an instrument (for instance, the C OM
port), one should:

. Change communication parameters through 3DOM

Open XPanelCommunicator configuration and start the change

Remove the instrument the communication parameters have been changed for.

Add again the instrument (in this way, the program will add it to the correct
communication channel or will create an apposite one)

5. If necessary, change the XPanelViewer configurations that use that instrument.

AN~

If however only the instrument network address is changed, it is sufficient to change it in
XPanelCommunicator configuration as well without changing the configuration of the viewers that

use it.

These considerations DO NOT apply to the instruments configured in the CommNetEG and
MQTTCommNet communication channel.
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4.8. Displaying instant values

In the View = Instant Values menu, you can access the window displaying the received instant
values:

.:";j Instantanecus Values =2 l = | =] |_i3-1

@ Thiz farm shows instantaneous values received fram data loggers

=- »f! CEMTRO-SIT Item Temperatura ['C]: 26,3
=E @ 35500 AM S Laszt walue Delta
: : i 2.3 iy
Average Standard dev.
262 0.1
Firiruirm EET
26.1 26.4
Tatal Mur. values
2E24 10
Errors
1]

CEMTRO-5IT - Temperatura ['C]: 26,3

This window shows the list of the communication channels present in the examined configuration,
the date/time of the last received data and the list of the available measurements along with their
value. Selecting an item from the list makes a detailed description appear on the right of the
window.

Not updated data are indicated with the suffix ‘o/d” added after the numeric value.

4.9. Log files

Log file management parameters are included in the NLog.config inside the installation folder of the
program executable.

Log files are stored in the folder:
{CommonApplicationData}\LSI-Lastem\XPanelCommunicator\Log

Where { CommonApplicationData} corresponds to:
e C:\ProgramData)\ in Windows Vista and Windows 7

e C:\Documents and Settings\All Users\application data in Windows
XP
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To change the level of the items included in the log file, change the minlevel value of the two lines
of the configuration file:

<logger name="*" minlevel="Info" writeTo="mainForm2"/>
<logger name="*" minlevel="Trace" writeTo="file"/>

In the order shown, the accepted values are:

e Fatal,
e Error,
e Warn,
e Info,

e Debug
e Trace

The recommended value is Warn. It is recommended not to set a level lower than Info.

4.10. End user license

The user will have to be provided with the license file associated to the instrument ID code, in order
to be allowed to use an instrument.

4.10.1. The Licenses Manager program

Use menu Options => Licenses Manager to run the program LS/ License Center which manages the
LSI programs licenses installed on the local computer.

The LSI License Center program is one of the components of the LSI Support Center program
which can directly be installed by the CD of LSI LASTEM products or from the CD of the licenses
files or downloading the installer file from LSI LASTEM FTP site. The LSI Support Center also
contains the component that checks for the availability of the new versions of the LSI LASTEM
programs installed in the computer (§Errore. L'origine riferimento non ¢é stata trovata.).

4.10.1.1. Installation of the program from the FTIP site

If the license management program is not installed in the local computer, you can download the
installation file from the LSI LASTEM FTP site. Installation will automatically start at the end of
download; once the installation is complete, the program will be started.

4.10.1.2. Program use
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The program displays all the licenses installed in the computer split in single programs or single
tools. Through this program, it is possible:

e to export the selected licenses in an archive file;

e to import an archive license file in the local computer;

e to produce a simple text file report with the list of the licenses installed in the computer;

e to directly download the license archives from the LSI LASTEM site;

The license archive consists in only one file zip with .Isilic extension: that is the format of LSI
LASTEM licenses.

Each license archive can be downloaded from the LSI LASTEM site by entering the License Code
supplied by LSI LASTEM on purchase of the programs.

_L_'é?: Download licenses from LSI LASTEM web site

@ Thiz farm allows pou to download licenzes from the LS LASTERM web site.
Inzert licenze code and press <Download:

Licenze code:;

[@ Download ] [ﬁ Cancel

The parameters of the Internet communication can be set through the Settings button, in case a
proxy server is present.
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4.11. Program internal configuration file

The program configuration file is named XPanelCommunicator.exe.config and is included in the
program installation folder. It is a xm/ file containing some operation settings of the application;
specifically, the program operation can be forced to work with a language different from the default
one, changing the value of the UserDefinedCulture property:

<setting name="UserDefinedCulture" serializeAs="String">
<value></value>
</setting>

To force the use of the English language on a computer with Italian as default language, enter
<value>en-us</value> value; to use the Italian language on a computer with a different default
language, enter <value>it-it</value>; other localizations are not available.
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5. XPanelViewer

XPanelViewer program displays the data transmitted by XPanelCommunicator through a TCP
connection using various indicators and graphic controls. Several pages of indicators can be
configured, and either the controls in the single page and the pages in the program main window
can be freely positioned.

5.1. User interface

The program main window has the following aspect:
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Canfiguration: Testl01 - Madified

Specifically:
e On the right, there is the panel representing the status of the communication conditions;
e The central area includes the pages where data-display graphic controls are configured (in the
example, two pages are shown)

View = Hide menu hides the menu bar, the button bar, the status bar and the window title showing
a minimal bar: press Restore to return to the classic display, Exif to exit the program, and drag the
bar to change the window position.
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Hide Menu display mode is restored if the program succeeds in automatically loading the last used
configuration.
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5.1.1. Menu

The program shows the menus below:

File

New: creates a new configuration.

Open: opens an existing configuration.

Close: closes the current configuration.

Save: saves the current configuration.

Save As: saves the current configuration changing its name.

Recent Configurations: displays the list of the recently opened configurations.
Exit: closes the program.

Edit
o FEdit Current Configuration: stops communication and opens the window for the current
configuration change.
o Automatic Page Change: sets the automatic page change among all the configured pages.

Connection
e Start Receiving Data: starts data reception;
e Stop Receiving Data: stops data reception.
e Reset: resets communication; at the end of the operation, a new connection with the
communication program will have to be performed.

View
o Arrange All Pages: rearranges the pages so as to make them all visible at the same time.
e Show Pages As Tabs: rearranges the pages so as to make only one page visible at a time.
e Hide Menu: hides the menu bar, the button bar, the status bar and the window title

Options
o Settings: shows the window with the program general settings.

Tools
o Show Sound Alarm Manager.: shows sound alarm manager window (§ 5.8).
e Reset Sound Alarms. resets all the sounding alarms (§ 5.8)
e License Manager: starts the license management program.

I+~

e Contents: shows the program user manual.
e Check for Updates: starts checking for the program update availability
e About: shows the program information window.

Some of these menu items are available also as button bar under the main window menu, place the
mouse pointer on a button and wait for a brief description to be displayed.
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5.2. Program general settings

The program general setting management window can be opened through the Options > Settings
menu:

.6'_[ Application settings [&J
. - |

@ Set application settings

| Run without user interaction

Time interval (seconds) to retry connection (set 0 to disable): 0 = sec
Time interval iminutes) to allow data reloading after edit or close 10 = min
Sound Alarm

Alarm sound file

C:A\ProgramDataL5-Lastem X PanelViewer\Libran \WARN WAV Iz
Alarm sound interval (seconds): 2 = sec |
[voe  [[ o

e

In this window, the program operation general mode can be set. Specifically:

e Selecting the “Run without user interaction” option, the program will not display any
blocking message and will operate automatically.

o Setting a Time interval (seconds) to retry connection higher than zero, the program will
automatically try to restore a connection in case of problems.

e When configuration is changed or closed, the data displayed by the various controls are
serialized to a file; when configuration is reloaded, the serialized files are reloaded and
displayed provided that the serialization date isn’t lower than the current date for a time
interval exceeding the minutes set in Time interval (minutes) to allow data reloading after
editing or closing.

In the Sound Alarm tab it is possible to set (§ 5.8):
e The WAV file with the sound of the alarms.
e The time interval in seconds between one alarm sound and the following.

ATTENTION

The automatic reconnection mode should be activated together with “Run without user
interaction” option, to prevent messages asking for the user reply from blocking a reconnection
in any case .
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5.3. Program startup: automatic reload of last
configuration

If the program is closed when a certain configuration is being used, this will be automatically
reloaded at the next program restart and communications will be automatically activated.

5.4. Opening a configuration

To open an existing configuration, select File > Open menu or File = Recent Configurations
menu.

After reloading the configuration, the program tries to activate the communication with
XPanelCommunicator on the TCP channel indicated in the configuration and starts data display, if
N0 eITors OCCur.

5.4.1. Setting a connection with the communicator

XPanelViewer configuration includes info on the TCP channel where XPanelCommunicator
program transmission takes place. The connection process goes through several phases:

e Connection: the program connects to the TCP channel indicated in the configuration and
starts communication with the communicator;

o Configuration check: the program asks the communicator to check configuration; if the
communicator configuration has been changed, the user is informed about the necessity of
changing also the viewer configuration; the program tries to automatically recreate the data
sources associated to the various controls and indicates all the controls without data sources
or with changed data sources (§ 5.5).

o Configuration request: the program asks the communicator for the data source configuration
and checks if all the controls set in XPanelViewer configuration are associated to a valid data
source.

e Data Recording: if the configuration is compatible, the program registers with the
communicator for data reception and starts receiving and displaying data.

5.4.2. Automatic operation

Setting “Run without user interaction” (§ 5.2) general parameter, the program doesn’t display
messages asking for the user interaction. Specifically:

e if the communicator configuration is not compatible with that of the viewer, the program puts
itself in a disconnected state;

e if the communicator configuration is compatible but shows errors, the program continues
informing about the warning status in the status window.

5.5. Communication status panel

On the right, the program indicates the communication status. The panel can be reduced or enlarged
to show all the available data by means of the buttons present in the upper part:
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The colored indicator represents the current configuration status; the date of the last received data
and the name of the relevant communication channel are shown as well.

The enlarged display shows the last received values from the communication channels and any
messages received during the configuration loading, as for instance controls with no data source or
controls with an automatically changed data source.

ATTENTION

Note that this indicator does NOT represent a connection with single devices (instruments) but
with XPanelCommunicator program. Furthermore, the date of the last received data referred to a
given communication channel only indicates that a measurement value was received from one of
the devices connected with that communication channel; the controls of the other measurements
might not yet have been updated. If for instance channel C1 is connected to one single device D1
including two measurements M1 and M2, that produce instant values every 10 seconds and every
30 seconds, the date of the last value received from channel C1 will update every 10 second, but
measurement M2 will update every 30 seconds only.

5.5.1. Colors of communication indicators

Based on communication conditions with XPanelCommunicator, the indicator shows the following
colors:

. O white: data reception interrupted
. Oyellow: communication in progress

Olight green: data received

.red: communication error

O grey: disconnected
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5.6. Creating a new configuration

To create a new configuration, select the File = New menu; in this way, a guided procedure is
started for the creation of a new configuration. The guided procedure shows the window for the
input of communication parameters, after asking for name and description of the new configuration:

- - -

MNew configuration procedure

Create a new configuration procedure: connection properties A |

ﬁl_.lﬁ

| Communicator is running on this computer

Communicator port 0 =

Reset the communication if no data is received for more than 30 2 minutes

Test Connection

< Previous ” Meod = | Cancel

e

After entering the connection parameters, press the <Test connection> button to check for its
validity: after - of course — starting XPanelCommunicator communication program.

In this form you can also enter a time in minutes for the control of communication: if the program
does not receive data for this time it assumes that you have a problem on the communication
channel of XPanelCommunicator and then it attempts to restart the communication. Setting the
value to 0 minutes the program disables this control.

At the end of the guided procedure, the window for the configuration modification is opened (§ 5.7)

5.7. Changing a configuration

To change the current configuration, select the Edit > Edit Current Configuration menu. This
selection opens the window for the configuration change.

ATTENTION
Communications with XPanelCommunicator are stopped to allow the modification of the current
configuration.
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The left section of the window shows the different pages of the configuration and the various
controls entered in each page; selecting an item displays its properties in the right section of the
window.

Specifically:

e To add a new page, press the <New Page> button.

e To remove a page, select it from the list, enable the context menu by right-clicking with your
mouse and select <Remove>.

e To rename the title of a selected page, select it from the list, enable the context menu by
right-clicking with your mouse and select <Rename > or change the property Title in the
property page.

e To change the property of a page, select it from the list and act on the property page
displayed on the right of the window.

e To change or test the connection with the communicator, press <Connection>;

e To add a control to a page, drag it from the list of controls to the desired page;
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To remove a control, select it from the list, enable the context menu by right-clicking with
your mouse and select <Remove>.

To rename a control, select it from the list, enable the context menu by right-clicking with
your mouse and select <Rename >.

e To copy a control from a page to another, drag it into the new page;

To change the property of a control, select it from the list and act on the property page
displayed on the right of the window.

5.7.1. Available controls

The available controls for data display are the following:

xyz

° label value indicator

° numeric indicator

hand indicator

thermometer indicator

. BB recipient indicator
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on/off status indicator

wind rose indicator

time chart control

table control

label states indicator

5.7.2. Properties of controls

Selecting a control from a page, its properties are displayed at the right of the window. The property
window is split in several tabs:

Hand Indic:atar - U aria

Yisual Properties | Data Source | Scale and Alarm | Mumeric Display

Property tabs:

Visual Properties: controls the aspect-linked properties such as position, size, border,
background, text;

Data Source: assigns a data source to the control (that is, a device measurement ) whose
value is displayed by the control;

Scale and Alarm: checks scale values and threshold values for the creation of alarms;
Numeric Display: checks the format, the character number and the colors of the numeric
indicator associated to the control;

Wind Rose: this tab is available only for the wind rose control and includes specific options.
Image: this tab is available only for the ON/OFF status control and indicates the control
display modes.

Y1 left axis: this tab is available only for the graphic control and sets the properties and the
data sources of the chart primary axis;

Y2 right axis: this tab is available only for the graphic control and sets the properties and the
data sources of the chart secondary axis;

Table: this tab is available only for the table control and sets the properties of the data
sources for each line of the table.
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When assigning properties to the single controls, note that these properties may vary slightly from a
control type to another.

Changing control properties has real-time effects on the page display; selecting a control on the
modification window automatically selects the corresponding control on the page and vice-versa. In
modification mode, pages show two rulers, a vertical one and an horizontal one, which allow a
better positioning of controls (§ 5.7.2.3):

Panel Viewer - Test001 (CASWnumStuffs\223\Dati Esemp| + Configuration Edit @
File  Edit ~ Connection  View  Options  Tools 7 @ Use <Mew Page> to add a page. <Connection? to change the connection. Select an item from the panel of configuration and change its
= 3 > T = properties. To add a contiol to a page drag it from the list of controls or from another page. Other options availables on the contest menu
D 5= | = | e e ‘ E ﬂ | L2 af the configuration items. i
Giardino” SIT
] w | m | o | o | 0 D Mew Page L, Connection [] Always on Top
—'I e b b e oo Conbols | Configuration
Ef N T et Hand Indicator - UmRel
Wisual Properties | Data Souce | Scale and Alarm | Mumeric Display
] Appearance
m_ Teat: UrnRel Colar
3 Border FivedSingle -
500
_ Paositions: 75 = ¥ 205 =Y
s
E Size: 334 = widh 725 |2 Height
]
E Background color: I:I Change Transparent
]
o] O = Antialias Shew flat
_ : L] 1 r
1008
-
21 Configuration: Test001 - Modified

Selecting the <Always On Top> option, the configuration modification window remains always in
evidence with respect to XPanelViewer pages.

5.7.2.1. Errors during data entry

If incorrect data are entered when changing the property data of a control, the program indicates the
error with a symbol:

Hand Indicater - UmB el

| Visual Properties I Data Source | Scale and Alarm | Mumeric Display

Scale
Start: 0 End: 10
Tick frequency related to scale limits: 15 0

i The tick frequency value must be less than the difference between end and start scale valw

| oy TV g SR Sy Y |
Placing the mouse pointer on the error signal displays a brief description.

5.7.2.2. Visual Properties tab
Visual Properties tab checks the visual properties of the control:

33



LSI LASTEM XPanel - User Guide

Visual Properties | Data Source I Scale and Alam | Numeric Displaj,r|

Appearance

Teut: Liv. Batt. | Colar
Text dimension factor: |_J | Extend

Border: FoeedSingle -
Positions: 287 = X 439 || Y
Size: 252 || Width 333 |2/ Height

Backaground color: Change Transparent

Background image:

]

| Artialias Show flat

Specifically:

Text shown on the indicator (Color button selects text color)

Text dimension factor specifies the size factor of the text in relation to the width of the
control

Border applied to the control

Positions and Size (see § 5.7.2.3)

Background color (Transparent = transparent background) or background image (if
available)

Antialias if set, improves the indicator graphic definition, however to the detriment of
performance (visualization is slightly slower)

The Aspect tab of the graphic control includes the following additional properties as well:

Time width of the graph data represents the amplitude of the graph on X axis: as new data
arrive, the data preceding this time interval are discarded (the maximum accepted value is 6
days, 23 hours and 59 minutes);

Show X-axis grid: if selected, displays the scale lines of X time axis;

Show legend: if selected, displays the legend

Text dimension factor

The text dimension factor specifies the size factor of the text in relation to the width of the control.
The effect of the change of this value is immediately displayed on the screen. This value does not
match the usual font size because the actual size of the text is redefined when you resize the control
or when you resize the page so as to maintain the proportionality between text and control width.
The button Extend sets the same relative size to the texts of all configuration controls in the page so
that all the texts are of the same size regardless of the size of each control.

In the Table control the text dimension factor sets the size of the title text of the table. The size of
the rows text of the table are set proportionally to respect to the title size.
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5.7.2.3. Position and size of controls on the page

The position of each indicator is defined by placing the top-left corner of each object on a X-Y grid,
as per the example grid below:

Y=0 X=0 X=100 |X=200 |X=300 |X=400 |X=500 |X=600 |X=700 |X=800 |X=900
Y=0 Y=0 Y=0 Y=0 Y=0 Y=0 Y=0 Y=0 Y=0 Y=0

100

200 Y=200 |Y=200 |[Y=200 |Y=200 |Y=200 [Y=200 |Y=200 |Y=200 |Y=200 |Y=200
X=0 X=100 |X=200 |X=300 |X=400 |X=500 |X=600 |X=700 |X=800 | X=900

300

400 Y=400 |Y=400 |[Y=400 |Y=400 |Y=400 [Y=400 |Y=400 |Y=400 |Y=400 |Y=400
X=0 X=100 |X=200 |X=300 |X=400 |X=500 |X=600 |X=700 |X=800 | X=900

500

600 Y=600 |Y=600 |Y=600 |Y=600 |Y=600 [Y=600 |Y=600 |Y=600 |Y=600 |Y=600
X=0 X=100 |X=200 |X=300 |X=400 |X=500 |X=600 |X=700 |X=800 |X=900

700

800 Y=800 |Y=800 |Y=800 |Y=800 |Y=800 [Y=800 |Y=800 |Y=800 |Y=800 |Y=800
X=0 X=100 |X=200 |X=300 |X=400 |X=500 |X=600 |X=700 |X=800 |X=900

Y=900 JY=900 [Y=900 |Y=900 |Y=900 |Y=900 |Y=900 |Y=900 |Y=900 |Y=900 |Y=900
X=0 X=100 |X=200 |X=300 |X=400 |X=500 |X=600 |X=700 |X=800 | X=900

X=0 100 200 300 400 500 600 700 800 X=900

It is possible to define X-Y positions with resolution to the unit (ex. X=320, Y=456). X and Y
maximum extension corresponds to 1000 value, no matter what the resolution of the used screen is.
E’ possibile definire posizioni X-Y con risoluzione all’unita (es. X=320, Y=456). L’estensione
massima di X e Y corrisponde al valore 1000, qualsiasi sia la risoluzione dello schermo utilizzato
Changing the values of position and size in the modification window, the control displayed in the
page changes its position and size in real time; similarly, you can select a control in a page with
your mouse and drag it using the two rulers as a reference: moving or resizing a control by means of
the mouse will automatically update the corresponding properties in the modification window.

5.7.2.4. Data Source tab

Data Source tab assigns the associated data source to the control, except for the graphic control,
were data sources are associated in Y/ left axis and Y2 right axis tabs, and except for the table
control where data sources are associated in the Table tab:
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Visual Properties | Data Source | Scale and &lam | Mumeric Display

Drata Source

Data source CEMTRO-SIT\Device[1\UmiditaRel [%) rate : 00:01:00

- Device[1] B
- UmniditaRe3k [%) rate : 00:01:
- Tempdnadd (] rate : 00070
- Prezst T [hPa) rate  00:01:0 3
- Ditdentoz2M [<] rate : 00:00:C
- Rad@lobal 51 [ 4md) rate : 01
- RadGlobak &2 Mwifm2) rate : [
- RadMETta [ fma) rate : 000
- LIWello [mm] rate ; 00:07:00

4 T 3

In order to assign/change data sources, communication with XPanelCommunicator should be
enabled; if enabled, select Show data source checkbox to display the data source list and select both
Device and Measurement for their association to the control.

Wind Rose control has two data sources, one for the direction and one for the wind speed:

Viisual Properties | Data Source | wind Rose | Scale and &lam | Numeric Display

Data Source
Direction GIARDINOYDevice[1hDirventoZ2h [<] rate : 00:00:02
Speed GIARDINOYDevice[1WelentoZ2b [mdz) rate : 00:00:02
7| Direction Speed
= Device(1] -~ = Device(1] -

- UmniditaRe3hd (%] rate : 00:01: - UmiditaRe3k (%] rate : 00:01:
- Tempdiaat [C]rate : 00070 - Tempdniadt [C] rate : 00010
- PressATH [hPa) rate : 00:01:0 7 - PressATH [hPa) rate : 00:01:0 7
- Dirento22M [<] rate : 00:00:C - DitdentoZ2M [<] rate : 00:00:C
- RadGlobal 51 [MWAm2) rate : 01 - RadGlobal 51 W /2] rate : OI
- RadGlobak &2 [ fm2) rate : [ - RadGlobak &2 [ fm2) rate : [
- RadMETta Mwiima) rate : 00:0 - RadMETta Mwiima) rate : 00:0
- LIYello [mm) rate ; 00:01:00 - LIYello [mm) rate ; 00:07:00

4 [114 3 4 [114 3

Label value indicator 1s the only control that may not have a data source associated. In this case no
warning message are shown

5.7.2.5. Scale and Alarms tab
Scale and Alarms tab checks the control scale, alarm thresholds and the activation of alarm sound:
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Wisual Properties | Data Source | Scale and Alarm | Mumeric Displa_l,l|

Scale
Start: o End: 100
Tick frequency related to scale limits: 10
Firror tick frequency related to zcale limits: 2

[ Shaw minimunn and masimun indicatar

Alarm

! Dizable ) Inzide limits @ Outzide limitz

Lower limit: 10 Higher limit: 70

Sound Alam

Activate sound alam

Hand Indicator, Thermometer and Recipient indicators

When setting numerical limits for alarms, the program assigns a different color (green or red) to the
indicator scale. When the measured value is associated to the red color, the digital value of the
quantity starts blinking, indicating an exceeded value. The set limit determines the alarm status
when the quantity value exceeds that limit.

Wind Rose Indicator
| isual Propetties | Data Source | wind Rose || Stale and Alam | Numeric Display
‘wind Foze

Show alarm when speed is greater than: 2

Mo alarm colors: - Change

Alarm colors: - Change

Scale max speed (m/'s): 2

Scale speed calm [m/s): 03

Select Show alarm when speed is greater than in m/s ; once this value is exceeded, the arrow
indicating the wind speed turns the color indicated in the Alarm colors box;

On/Off Status Indicator
When selecting Activate sound alarm every time the data source of the control raises an error event

on an alarm state the program will sound. This sound will stop only when the user acts directly to
stop it (§ 5.8)

Sound Alarm

Activate sound alam
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5.7.2.6. Numeric Display tab
Numeric Display tab checks the format of the numerical indicator associated to the control:

Vizual Properties | Data Source | Scale and Alarm N

General

| Show numeric display

Characters nurber: 3 = Faormat: Qoo

The numnber format is ke "000.0", the number of digits mst match what iz get in "Characters
Mumber'', while the position of the decimal separator iz optional

Colors
Digits: | Change |
Backaround: | Change | | Tranzparent

Alarrr: | Change |

Specifically, set the number format to determine the position of the decimal separator, expressed as
“000.0”; the number of digits should correspond to the value set in Characters number, while the
position of the decimal separator is optional.

5.7.2.7. Wind Rose tab
Wind Rose tab is available only for the Wind Rose control:

Wisual Properties | Data Source Scale and Alammn | Mumeric Dizplay

Wind Rose
| Show numeric direction - label Dir 22m
Color

| Show numeric wind - 1abel Wind 22m

V| Show scale V| Show sector

Transparent Levels 25
Last directions o=
Maorth angle i} =

Specifically, the selection of (1,2,3) levels changes the control aspect as follows:

- — e 1
| B : ool o ool
| 1 ]

L

Liwelis1 Lineella 2 Loiwi o3

Displaying the last n directions and the scale changes the control aspect as follows:
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Lastdirection@\.r - - HE
Scale TN Y

5.7.2.8. Image tab (On/Off Status indicator)
This tab controls the display mode of the ON/OFF Status indicator:

Visual Properties | Data Source

Image

@ Light indicator

On status color: Change
OFff statuz color: - Change

Selectable image

The status display can be set in two different ways:
e Light indicator: in this case, it is sufficient to specify the indicator color for the ON or OFF
status; in case of error, the indicator is highlighted with a red cross.

o Selectable image: an image corresponding to the three status conditions is selected: ON,
OFF, ERROR. There is no alarm warning on the status indicator.

We call to mind that the status control is OFF when its value is 0 and it is ON when its value is
other than 0.

5.7.2.9. Min Max Values tab
This tab controls the recording mode of the minimum and maximum values:
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Records Minimun and Maximum Value

| Register and show minimum and maximum values

Reset valuss every:  [EEN -

o Select Register and show minimum and maximum values to activate the recording of the
minimum and maximum values;
e Select an option from the list to reset recorded values.

The options to reset recorded values are:
One minute

Ten minutes

One hour

Three hours

Six hours

Twelve hours

One day

Ten days

One month

Please note that by choosing for example three hours, the statistics are reset at 0, 3, 6, 9, 12, 15, 18,
21, similarly to the other selections. The selection fen days must be understood on a monthly basis
and then resets the statistics at the beginning of the month, and at days 10 and 20.

5.7.2.10. Graphic control tab of Y1 Left Axis and Y2 Right Axis

These two tabs can be viewed only through the graphic control; they supervise the aspect and the
configuration of vertical axes; the primary axis is Y1 axis (left axis in the chart):

Time Chart - Rad

Wisual Properties [} 11 Left A2t v2 Right Asxe

1 - Left Axe
Diagram Type: Line -
Wisible Axe Grid Measure Unit: Wime
Automatic Scale Start: 0 End: 800
Data Sources Add
GIARDIMO40904064.34R adGlobal 51 fw'/m2] rate - 00:00:10 Femove

GIARDIMONI30406434R adGlobak s [ fm2] rate - 00:00:10

Exdit

Specifically, the following can be set:
e Type of chart (line chart or bar chart);
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e Grid visibility and measurement unit that is displayed as the axis tag;
the scale can be automatic, in other words set based on the effectively available data, or
manual;

e Data sources.

The secondary Y axis (Y2) is disabled by default: to enable it, select Enable Y2 right axis in the Y2
Right Axis tab.

Each axis can be associated to several data sources (sources having the same measuring units are
obviously recommended); to add a data source, select <Add>, press <Remove> or <Edif> buttons to
remove or change a data source after selecting it from the list.

The data source list allows to set also the color of the chart associated to that source:

' Add Data Source to Chart i

@

Select a data source and a color and then press <Ok to
add it bo the chart data sources list.

(:- Lire/Bar color:

—

_ Change B _>

~ CEMTRO SIT

= 05110003
il Temperatura ['C] rate : 00:01:00
= riditaRel [%] rate : 00:01:00

m

= I GIARDIND
S 0904043
e UnniditaRe3M (2] rate : 00:01:00
e e Tempdriaddd ['C) rate : 00:070:00
| -~ [ PresstTM [WPa) rate : 00:01:00
e Ditento22h [<] rate : 00:00:02
- FadGlobalS1 [wAm2) rate : 00:00:10
» RadGlobak & W /ma) rate - 00:00:10
- [ RadMETta [w'/m2) rate : 00:00:10
» LIVeella [ram) rate : 0000700 L

ATTENTION:

If a bar chart with several sources is selected, note that bars are drawn in the same position
starting from the first data source. If, for instance, there are two data sources (S1 and S2) that -
at a certain point - assume VI and V2 values with VI>V2, the bar of the second series will not be
visible. The use of a single data source is recommended with bar charts.

5.7.2.11. Interactivity graphic control

Using your mouse, you can zoom and scroll the data included in the graphic control. To zoom, left-
click on the start point and drag your selection to the end point before releasing the mouse. The
zoom function acts both horizontally and vertically always using the primary Y axis (Y1). When the
chart is in zoom mode, the scrollbars are displayed:
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Act on the scroll bars to:
Scroll the selection by dragging the scroll bar
Enlarge/reduce the zoom area by acting on the scroll bar

Remove the zoom by clicking on the buttons e

5.7.2.12. Table control and Table tab
This tab can be viewed only for the Table control and allows to specify the data sources associated

to each table line:

Row Data Sources

Width of the columns of data with respect to the "Date” |80 24| %
column
MName Data Sources Add
Um Rel CommMetEG Bus TESTH13052057... =
Bemove
Edit

The parameter Width of the column of data with respect to the Date column sets the width of the
columns of data in percentage to the width of date column. The real size of the columns depends on

the width of the control since the table occupies the entire width of the control.
In this tab, use <Add>, <Remove> and <Edit> buttons to add, remove or change the table lines.

Specifically, pressing <4dd> or <Edit> opens the window showing all the available data sources:
enter a name for the heading of the table line and a data source.

The Table control supports the Min Max Values tab (§ 5.7.2.9): if you select to record the min and
max values, the table will show two other columns of data.
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5.7.2.13. States Tab
This tab controls the states of the new Label States Indicator:

General Settings

Percentage of the control for the image 0

[] ¥ selected image is placed under the title

States
Range Text
0 <> Dry Remaove
10 ==19 Rain
==29 Snow

T

L

e Percentage of the control for the image: if states are associated to images this value sets the
part of the control devoted to show the image; the image size will be stretched to the control
size;

o [f selected image is placed under the title: if the states are associated to images check this
control box to show the image under the title; in this case the previous parameter refers to
the vertical dimension, otherwise it refers to the horizontal dimension.

e The Add, Remove, Edit buttons change the values of the states.

e The buttons with the vertical and horizontal arrows change states order in the list

e The Test button sets the selected range value to the control on the page to show the real
effect of the control.

The Add and the Edit buttons show the form to set state characteristics:
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B Add/Edit State [

@ Thig form adds or editz a State item. f you do not select any image the control will show the Texst; if you
select a valid image the control will show the image and the text as a tooltip.

Start: 10 End: 15

Tend: Rain

Image: C]

i you do not select any image the contral will show the Text; f you select a valid image the
contral will show the image and the text as a tooltip.

Each state is characterized by a range of values (for integer states use the same value as the Start
and the End), a text and an image optional. If the image is not set the control will display the
corresponding text attached to the title, otherwise the control will display the image using the
settings described above: in this case the text will be indicated by the tooltip on the control.

Please note that the verification of the status values is made from the first level and including the
extremes.

5.7.3. Message of Data error or Not updated data

When XPanelCommunicator stops communications or sends data errors, controls display Err; to
make the value blink, set a color different from that normally used to represent the data for the
Alarm value in the Numeric Display section:

encry

|| Show rurnenc daplay

Charachars numbear 3 = Faimat: oo

The number foomat iz Bke 000", the numies of digits must match what iz sef in“Characters
Humber", whils the positian of the decimal ssperstar = aptianal

I:UUI":
Digits: - | Change |
Backguound | | Change || Tranzparant

.
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The graphic control doesn’t show this condition, but it will not assign any new data.
5.7.4. Closing and saving

When a configuration modification window is closed, the program checks that there are no errors
and that all controls are associated to a valid data source, otherwise it informs that it’s up to the user
to decide if to continue or not to save data.

If the configuration has been changed, it is reloaded and the connection with XPanelCommunicator
re-established, even if the user cancels the changes.

5.8. Management of Alarm Sound

The Sound Alarm tab allows you to activate the sound alarm for controls that support this feature, in
version 1.3 the only enabled control to manage the sound alarm is the on / off state one.

| Visual Properties I Data Source I Image |

Sound Alarm

Activate sound alam

If you activate the sound alarm, whenever the data source associated with the control detects an
alarm condition or an error the program emits a sound that only ends when the user acts directly to
deactivate it.

r —
@ Sound Alarms Manager . I&

@ This window shows the status of the sound alams. |t is possible to break the sound of one or more alams by setting a latency time or to
remove the latency of blocked alamms.

Press to stop the alams selected in the list for the nest (10 = minutes

Sounding Alarms Date OnEmar
[7] Nuova Pagina* ALLARME 2 {cNoAllarme) 12972013 331 PM
L
Click to remove expiration time of slected blocked alarms
Blocked Alams Expiration time of block
[7] Nuova Pagina“"ALLARME 1 {cAllarme Sonoro) 12/9/2013 34156 FM
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This window displays at the top the indicators list with a sound alarm in progress and at the bottom
the one whose sound alarm has been stopped.

To stop the alarm sound, select the check box of the indicators in the Sounding Alarms list, set the
time of suspension and press the button <Sfop>. Automatically these indicators are moved in the
Blocked Alarms list.

To unlock the alarm sound, select the check box of the indicators in the Blocked Alarms list and
press <Remove>. If the associated data is still in error or in alarm, the sound alarm restarts to play
and the indicator are moved in the Sounding Alarms list.

WARNING
Please note that the sound continues until the user removes every indicator in the sounding
alarms list.

This window is activated every time the program activates a sound alarm, or if the user select the
menu Tools 2 Show Sound Alarm Manager. The menu Tools = Reset Sound Alarms stops all
sounding alarms and cancels the time of suspension of all indicators already stopped.

The program records in a log file (§ 5.9.1) all changes of the status of the indicators for which the
sound alarm is activated and all the actions of recognition made by the user.

5.9. Log file

Log file management parameters are in the NLog.config file included in the installation folder of the
program executable.

Log files are stored in the folder:
{CommonApplicationData}\LSI-Lastem\XPanelCommunicator\Log

Where { CommonApplicationData} corresponds to:
e C:\ProgramData\ in Windows Vista and Windows 7

e C:\Documents and Settings\All Users\Application data in Windows
XP

To change the level of the elements included in the log file, change the minlevel value of the two
lines of the configuration file:

<logger name="*" minlevel="Info" writeTo="mainForm2"/>
<logger name="*" minlevel="Trace" writeTo="file"/>

The admitted values are in the order:
o Fatal,

Error,

Warn,

Info,

Debug

Trace
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It is recommended not to set a level lower than /nfo; the recommended value is Warn.

The program records a log file every day. Log file name is logyyyy-mm-dd.txt where yyyy-mm-dd
represents the current date.

5.9.1. Log file of sound alarms

Sound alarm log file name is AlarmLogyyyy-mm-dd.txt where yyyy-mm-dd represents the current
date.

5.10. Program internal configuration file

The program configuration file is named XPanelViewer.exe.config and is included in the program
installation folder. It is a xml-format file containing some application operation settings;
specifically, the program operation can be forced to run with a language different from the default
one by changing the value of UserDefinedCulture property:

<setting name="UserDefinedCulture" serializeAs="String">
<value></value>
</setting>

To force the use of the English language on a computer set in Italian, enter <value>en-
us</value>; enter <value>it-it</value> to force the Italian language on a computer set with a
different language; other localizations are not available.
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6. Auto Updates

Use menu ? > Check for updates to run the LSI Update Center program, which checks the
availability of the new versions of the LSI LASTEM programs installed in the computer.

The LSI Update Center program is one of the components of the LSI Support Center program
which can be directly installed by the CD of LSI LASTEM products or from the license files CD, or
by downloading the installation file from the FTP site of LSI LASTEM. The LSI Support Center
includes also the component which manages the licenses of the programs installed on the local
computer (§4.10).

6.1.1. Program installation from the FIP site

If LSI Update Center program is not installed on the local computer, you can download the
installation file from the LSI LASTEM FTP site. At the end of the download, the installation will
automatically be started; at the end of the installation, the program will be started.

6.1.2. Using the program

The LSI Update Center program consists in two modules:

e LSI Update Center Monitor program that is automatically started with the operating system
and periodically checks for the availability of updates for all the LST LASTEM programs
installed in the computer.

o LSI Update Center program showing the state of the available updates and downloads, if
necessary, the installation files from LSI LASTEM web site and starts the update
installation.

The LSI Update Center program shows the state of the LSI LASTEM programs installed in the
local computer:
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LSl Update Center

® Cloze C&' Search Settings 151 { astem | e |

Update Center has detected that one or more products need fo be vpdafed,
#% Double click the product to update on the list ta start download or select Search to refresh praducts informations.
Lask search performed on: 482009 2:46 PM

Product Current Werzion Last Werzion Dimenzion | Level
& 300K 2000 2220 .58 MB Recommended
& CommMeltEG 2220

2 GidazT oSynop 1.1.01 1.1.1.1

O GidasViewer 2000

2 InfoGAP 2200 2230

@ LS1 Evapatranspiration 1.030

@ LSl Lib. Gidas. whiter 1.000

@ L51.PHSMicraClimate 1.1.3.0

ﬁ LS1.5Itn. Librantd anager 2000 20120 432 ME b arginal
@ LS1.SuppartCenter 1.000

3DO0M: the updating is available to the version 2.2,2.0 {dimensions; 6,58 ME)
"j Fhe updating is recommended

Select Information visualize the list of the contained changes in the last wversion.

The installed current version and the last available version are displayed for each program. A
program can be in one of these conditions:
e updated;
e not updatable: a new version exists but the product is not updatable;
e updatable: double click the product to be updated on the list to start downloading the
installation file.

Selecting Information displays a web page containing the list of the changes of all the versions of
the selected program.

Pressing Search starts the search for updates, while pressing Settings changes the connection
properties, if a proxy is used, along with the time interval used by the monitor for the update
automatic search.

Keep in mind that when this program is started through Windows Start = Programs menu or from
the monitor context menu, the program displays the results of the last automatic search performed
by the automatic monitor displaying the search date. To update data press the Search button.
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